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Chapter 1

111b27b8-0

1.1 Table of Contents

LhA-GUI, Version 1.13
© 1994-1996 Brian D. King
Fourth Dimension Software

All Rights Reserved

Table Of Contents
1.

~General~Information~
2.

~Requirements~~~~~~~~
3.

~Features~~~~~~~~~~~~
4.

~Installation~~~~~~~~
5.

~Instructions~~~~~~~~
6.

~Future~Enhancements~
7.

~History~~~~~~~~~~~~~

1.2 General Information

This package attempts to provide a useful and usable front-end for
Stephan~Boberg’s LhA~software package, as well as the new LZX archive
compression scheme. It is not meant to provide the transparent use~of LhA
archives as~volumes or directories on the Amiga (ObjectArchive will do~that,
see the AmiNET index).

Instead, LhA-GUI’s purpose is to provide a dedicated application approach
to~LhA archive~extraction handling. It has loads of

~features~
, and has

many~
~future~
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plans.

Please read this documentation fully, and please report any bugs to
the~author:

Brian D. King (Brian_King@software.mitel.com)
Fourth Dimension Software
1-420 Fenerty Court,
Kanata, Ontario, Canada
K2L 3A9

LhA-GUI is shareware. Freely distributable via CD, disk, FTP, or any other
form. No profit may be made with the distribution of this software, and I
must be contacted first before it is included on any cover-disk, or before
being used as a front-end for archives on any media-type.

LhA-GUI, ©1994-1996 by Brian D. King, Fourth Dimension Software.

1.3 Requirements

- Amiga OS, 2.1 or higher.
- PIPE: mounted (via DosDrivers or mount-list).
- LhA/LZX executable in your path or c: directory. Registered or

unregistered should be fine.

1.4 Capabilities/Features

- Amiga User Interface Style Guide compliant.
- Drag and drop support of both source archives and destination paths.
- Iconification onto the WorkBench.
- Support of notification. LhA-GUI automagically adjusts itself if

you change a WorkBench setting (like font or resolution).
- Workbench AppIcon which supports auto-extraction of any archive

to the default extraction directory.
- File hierarchy display of a given .lxx archive, with the ability to

select specific files for extraction, along with easy control of
numerous Lxx options.

- NTSC/PAL hi-res support (window will fit on 640x200 screen).
- Font-adaptive, size-adaptive without use of an external library!
- MultiView (or other viewer) support, called by double-clicking on

archive-entry.
- Under 55K in size.
- Easy to use.

1.5 Installation

To install LhA-GUI, you must do the following:
- Extract the archive, which you’ve probably done if you’re reading

this.
- Choose whether you want MagicWB style icons, or normal 4-colour icons.
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If you want MagicWB icons, delete the 4-colour icons directory.
If you want the 4-colour icons, copy them over the existing MagicWB
icons.

- Place the LhA-GUI program somewhere.
- Make sure PIPE: is being mounted.
- Make sure you have LHA/LZX in your path somewhere.

NOTE: An installation script for Commodore’s Installer software will be
forthcoming. If you have problems with the current installation,
feel free to e-mail me, see

~general~
information for address.

1.6 Instructions

Select which area of the interface you require help with:
1.

Main~LhA-GUI~interface
2.

Preferences~~interface

1.7 Future Enhancements

These modifications/enhancements will be completed soon (in this order)
- Online help for OS 2.x users.
- Better progress indicators.
- Commodore Installer installation script.
- Keyboard control of ListView (Up/Dn, space-bar to toggle, ENTER to go

into a directory)
- Drag-select in ListView.
- Preferences settings for CON: output window.
- Preferences settings for LhA-GUI window size/position.
- ToolTypes for program, along with more CLI-options.
- Locale compatible.
- <Insert your suggestions here>

1.8 History

- Beta Release 1.00, December 18, 1994.

- Beta Release 1.01, December 24, 1994.
. Fixed path problem with destination parameter.

- Beta Release 1.02, December 30, 1994.
. Fixed problem with iconification. <Barry McConnell>
. Fixed problem with double-click actions. <Barry McConnell>
. Fixed problem with spaces in archive name or path. <Barry McConnell>
. Cleaned up error message text strings. <Barry McConnell>

- Beta Release 1.03, January 12, 1995.
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. Fixed problem with double Enforcer-hit during
extraction. <Barry McConnel>

. Added LINE debug information for compatibility with FindHit, an
Enforcer tool. Now, you too can help find problems with LhA-GUI!

- Beta Release 1.04, January 13, 1995.
. Fixed problem with NULL-fields as first element in an archive

directory listing.
. Recompiled all modules with LINE debug (instead of some with LINE

and some with FULL), resulting in a size reduction of 20K.
. Removed Xen font from beta-distribution archive, reduces archive

size.
. Fixed non-functioning Delete and Test gadgets by disabling them!

- Beta Release 1.05, January 17, 1995.
. Fixed problem with empty archive and destination string gadgets.
. Fixed problem with list-gadget not being cleared properly.
. Rearranged some code, slightly smaller/faster.
. Started phase-out of GadToolsBox code. Working towards font and

screen adaptivity. Internally, ListView can be any vertical size.

- Beta Release 1.06, January 23, 1995. (Major revisions)
. Fixed problem with Select-All functionality. If you did a Select-

All, followed by an Extract operation, only the root-level of the
archive was extracted. <beta-tester>

. Fixed keyboard-shortcuts. Had a conflict, and now allows the e/E

. key to select "Extract".

. Fixed bug in archive parsing, when last part of archive-list was a
comment.

. Added standard four-colour icons to archive. <beta-tester>

. Added font-sensitivity to list-gadget. Uses ScreenFont.
<Barry McConnell>

. Added ClipRect to list-gadget, prevents overflowing text.

. Added coloured text for directories.

. Added MultiView support for archive entries. <Barry McConnel,
Kerry Paulson>

. Added command-line archive specification for CLI-launching.
<Kerry Paulson>

. Added Test gadget code, allows archive testing.

. Added ability to drop an archive on the iconified program. <Barry
McConnell>

. Added self-detaching code for CLI-launches. Don’t need to run me!

- Beta Release 1.07, January 23, 1995. (Major bug-fix)
. Fixed problem with large amount of files in an archive. This would

flood the PIPE-line with file-names, before a parsing function could
be called. Fixed this by making "lha" System() call asynchronous,
thus allowing the parsing function to begin emptying the PIPE right
away. <Dean Smith>

- Beta Release 1.08, February 9, 1995. (Major bug-fix)
. Fixed problem with selecting large amount of files in archive. This

would fill an internal string buffer. The string buffer is now
dynamic, to allow for any number of item selections. <Kerry Paulson>

. Fixed functionality with selecting a directory name, but not anything
in it. The entire directory is now extracted.

. Fixed problem with selecting file-names at the root-level of the
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archive. Before, the entire archive would end up being extracted,
rather than just the selected files.

. Added full font-sensitivity. <everyone>

. Added WorkBench argument support of archive specification. <Kerry
Paulson>

. Added seperate Preferences window. <Barry McConnell>

. Changed LhA-GUI.guide’s default to be "AmigaGuide". <Dana Peters>

. Changed MultiView launch to be asynchronous (runs in background).
<Barry McConnell>

. Removed LINE-debug code, so FindHit won’t work. LhA-GUI is now 41K
in size, and nobody was sending me Enforcer-hit reports.

- Beta Release 1.09, February 13, 1995.
. Fixed keyboard shortcuts in both windows.
. Fixed link with "boopsi.o", a left-over from GadToolsBox days. No

longer need this. All GadToolsBox code removed, no external
libraries needed for font-adaptivity.

. Forgot to include LaunchMultiView.script in distribution archive.

. Added resizability to main interface.

- Beta Release 1.10, February 21, 1995.
. Fixed Topaz8 rendering bug. Now if LhA-GUI won’t fit on your

screen because of its font, LhA-GUI will default back to Topaz8
for its layout. <me>

. Fixed ASL requesters, now block input to parent window. <Barry
McConnell>

. Fixed bug with filling background of window after resizing. Some-
times it would be rendered with the wrong pen. <Dana Peters>

. Fixed menu-rendering, now use NewLook menus. <Timothy Aston>

. Fixed iconification. Iconify now remembers last window size and
position. <Barry McConnell, me>

. Fixed prefs window. Now opens relative to main window’s top left
position. <Barry McConnell>

. Fixed prefs destination directory functionality. Now, when you
change your preferences of default destination directory and then
select either ’Save’ or ’Use’, the destination directory gadget in
the main window will be updated. <Barry McConnell>

. Changed ASL file-requester gadgets to scalable file-folder images.
<me>

. Changed compiler options, reduction of 1K in size. (StringMerge,
UtilLib). <me>

. Changed layout code, border-spacing now equal. <me>

. Added visual cue for keyboard short-cuts. Now when a boolean gadget
is selected via its keyboard equivalent, the gadget is depressed and
released. <Barry McConnell>

****************************************************************************

- General Release 1.11, March 14, 1995.
. Eliminated elipses (...) from various requesters. <Barry McConnell>
. Changed main window title to simply "LhA-GUI". <Barry McConnell>
. Fixed resizing refresh bugs. <Barry McConnell, me>
. Added notification support. If you change your WorkBench font,

screen, or overscan settings, then LhA-GUI automagically iconifies
itself. <me>

. Fixed requesters and parent window. Parent window is now blocked,
complete with a busy-pointer. This happens for ALL requesters, not
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just ASL requesters. <Barry McConnell, me>
. Added small status-window for description of whats happening. <me>

- General Release 1.12, March 26, 1995.
. Fixed Enforcer hits when resizing window and no archive selected.

<me>
. Fixed MAJOR iconification bug. If you launched LhA-GUI from the

CLI via a path (but not actually in the LhA-GUI directory), and
then iconified, you got instant fireworks! KABOOM! This has now
been fixed. <me>

. Fixed MAJOR extraction bug. Files selected in root-level were
ignored. Also, if the *only* files selected were in the root-level,
they would be ignored and the *entire* archive would be extracted.
<me, others>

. Fixed notification bug when LhA-GUI was already iconified. <me>

. Fixed window-sizing/zooming being available when ASL requesters
were open. <Barry McConnell>

. Fixed (???) glitch when selecting size gadget, but not actually
changing size. Two problems here:

1. Text in status display would be mangled. <Barry McConnell, me>
2. Extra refreshing would occur. <Barry McConnell>

. Changed gadgets so that they are disabled when no archive present.
<Barry McConnell>

. Changed notification so that LhA-GUI closes its window, and reopens
10 seconds later. It *does not* iconify during notification. It
simply disappears and then reappears later. <me>

. Changed LhA-GUI.guide file, added two new sections (installation,
instructions). <me>

. Changed compile method, uses pragmas now. Reduced code size by 3K.

. Added more status display messages (archive extraction, testing).
<Barry McConnell>

. Added quick-help for various gadgets (OS 3.x only, for now). <me>

. Added online context-sensitive help (OS 3.x only, for now) via an
AmigaGuide link to this file. <me>

- General Release 1.13, January 7, 1995.
. Fixed problem with unflushed messages which occurred while LhA-GUI

requesters were open on screen (ASL requesters, to be specific).
<Barry McConnell>

. Fixed duplicate list entries. This happened if an archive was
originally created under UNIX, and had a directory entry called
"BLAH" and "blah". Since the Amiga doesn’t care, I coalesce these
entries now. <me>

. Fixed memory leak. About 3K in size. I’ve now tested thoroughly,
and can’t find anymore leaks. <me>

. Fixed OS 2.x crashing. I was using a V39 (OS 3.x or higher) library
function, GetUniqueID(). <me>

. Removed PowerTools.lib requirement. <me>

. Changed LhA-GUI.guide file. <me>

. Added deletion support (buggy). <me>

. Added online context-sensitive help for menu-items, still OS 3.x
only. <me>

. Added LZX support. Still preliminary, and not extensively tested,
since I don’t have many LZX archives currently. <me>

. Added ability to have an auto-extract icon present at all times.
This AppIcon (LhA-GUI Extractor) will unarchive the complete
contents of any archive dropped on it, to the specified default
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extraction directory (set up in LhA-GUI preferences settings).
<Barry McConnell>

1.9 Main LhA-GUI interface

Window Interface Functions
1.

~Choosing~an~archive~~~~
2.

~Choosing~a~destination~
3.

~Navigating~the~listing~
4.

~Extracting~files~~~~~~~
5.

~Testing~the~archive~~~~
Menu Contents

Project

~Iconify~~~~~

~Preferences~

~About~~~~~~~

~Quit~~~~~~~~
AppIcon (iconified) Functions

1.
~Choosing~an~archive~~~~

2.
~Choosing~a~destination~

3.
~Re-activating~LhA-GUI~~

1.10 Preferences interface

Window Interface Functions

~Choosing~default~source~directory~

~Choosing~default~target~directory~

~Compression~speed~~~~~~~~~~~~~~~~~

~I/O~Buffer~size~~~~~~~~~~~~~~~~~~~

~LHA~option~check-boxes~~~~~~~~~~~~

~AutoExtract~AppIcon~~~~~~~~~~~~~~~

~Close~Gadget~Iconifies~~~~~~~~~~~~
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~Choosing~a~viewer~~~~~~~~~~~~~~~~~

~Save~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

~Use~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

~Cancel~~~~~~~~~~~~~~~~~~~~~~~~~~~~
Menu Contents

Edit

~Reset~to~Defaults~

~Last~Saved~~~~~~~~

~Restore~~~~~~~~~~~

1.11 Choosing a destination

Choosing a Destination Directory

Using the Directory Gadget

To select a destination directory for archive extraction,
you~must~either~type~a~valid~directory-name into the string gadget, select the
keyboard~shortcut~(y),~or~select~the~file-requester image to the right of the
string gadget.

Both the keyboard shortcut and the file-requester image will
pop~up~an~ASL~directory~requester.~Through this, you can simply select a
directory, and~it~will~become~the~destination directory~for archive
extraction.

Using Drag-And-Drop

Simply drag a drawer or volume onto the LhA-GUI window to change the
destination directory.

When Iconified

Simply drag a drawer or volume onto the "LhA-GUI (sleeping)" icon to change
the~destination~directory.

1.12 Choosing an archive

Choosing an Archive

Using the LhA Archive Gadget

To select a source archive for viewing, extraction, testing, or deletion,
you~must either~type a valid archive-name into the string gadget, select
the~keyboard shortcut (L), or~select the file-requester image to the right of
the~string gadget.



111b27b8-0 9 / 15

Both the keyboard shortcut and the file-requester image will pop up an
ASL~file requester.~Through this, you can simply select an archive, and it
will~become the source archive for~future LhA-GUI operations.

Once the archive has been selected, LhA-GUI will verify that it is a
valid~archive, and~will then present a directory-tree structure which
represents the~contents of that~archive. This directory tree is in fact a
custom list-view~gadget, and can be

~navigated~
~.

Using Drag-And-Drop

To select a source archive, simply drag-and-drop an archive (from a Workbench
drawer) into the LhA-GUI window.

When Iconified

To select a source archive when LhA-GUI is
~iconified~
, simply drag-and-drop

an archive~(from a Workbench drawer) onto the "LhA-GUI (sleeping)" icon. This
will reopen the main~window, and build the directory tree for the new archive.

1.13 Navigating the listing

Navigating Through the Archive’s Contents

Once an archive has been selected, its contents will show up in the
listview~gadget. These~contents are organized as a directory tree, and can be
navigated~accordingly.

Highlit entries are directories, and may be entered via a double-click.

Double-clicking a non-directory will un-archive that particular file, try
to~view it using~the viewer set up in your preferences "Viewer", and finally
will delete the file~when finished viewing.

To go back a directory, you can use the parent gadget located just below
the~listview. To~go back all directories, you can use the root gadget.

To select all of the files in a particular directory, you can use the
select~all gadget,~and to clear them, use the clear all gadget.

1.14 Extracting files

Extract Gadget

Once an archive has been loaded, you can select various entries in the
archive~(via the~listview). Presuming you’ve selected a destination
directory, you~may now select the~Extract gadget, either by using the mouse
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or~by using the~keyboard shortcut (E).

If you haven’t selected any files in the archive, the default operation
of~Extract is to~extract the complete contents of the archive to the
destination~directory.

Extract always opens up a small console window, which shows the progress
of~the actual LHA~command. When the operation is complete, you can
close~that~window by clicking on its~close-gadget.

NOTE: Extract operations follow the LHA-GUI preferences
settings~for~

~LHA~options~
.

If you’re having problems with extraction (no directory contents,
wrong file protection bits, etc.), make sure you’ve set up the
LHA options correctly.

1.15 Testing the archive

Test Gadget

Once an archive has been loaded, you can test the archive. This is done
by~either~selecting the Test gadget with the mouse, or using the keyboard
shortcut~(T).

Test always opens up a small console window, which~shows~the~progress~of
the~actual~LHA~command. When the operation is complete,~you~can~close
that~window by clicking~on~its~close-gadget.

1.16 Project Menu - Iconify

Iconify Menu Option

By selecting Iconify from the Project menu of LhA-GUI, or by using the
assigned hotkey (Right-Amiga I), you can iconify LhA-GUI. This means that the
LhA-GUI window will disappear, and a small AppIcon will appear on the
Workbench, titled "LhA-GUI (sleeping)".

Don’t worry! You haven’t lost anything, or eliminated your choice of archive
and destination directory. Simply double-click the AppIcon and LhA-GUI will
reappear where it last was, with all of your selections intact.

1.17 Project Menu - Preferences

Preferences Menu Option

By selecting Preferences from the Project menu of LhA-GUI, or by using the
equivalent hotkey (Right-Amiga P), you gain access to LhA-GUI’s preferences
window. Here you can change LHA options, the default source directory for
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your archives (perfect if you always download .lha files into a specific
directory), and the default extraction directory.

See the
~Preferences~Interface~
section for more details.

1.18 Project Menu - About

About Menu Option

By selecting About from the Project menu of LhA-GUI, you will see information
about the author (see also the general information section), the tools used
to create LhA-GUI, and those peoples/companies whom I wish to thank.

1.19 Project Menu - Quit

Quit Menu Option

By selecting Quit from the Project menu of LhA-GUI, you are able to exit this
fine program. The~same result can be achieved by clicking on the close gadget
of the LhA-GUI main window.

1.20 Re-activating LhA-GUI

You can reactive the iconified form of LhA-GUI by simply double-clicking on
its AppIcon, by dropping an archive onto its AppIcon, or by dropping a
directory or volume name onto its AppIcon.

1.21 Choosing default source directory

Default Source Directory Gadget

By selecting this gadget, either with the mouse or its keyboard shortcut (O),
you can select the default directory where archives can be found. This
simplifies selecting archives from the LhA-GUI main interface by starting the
ASL file requester in this directory.

1.22 Choosing default target directory

Default Extraction Directory Gadget

By selecting this gadget, either with the mouse or its keyboard shortcut (X),
you can select the default path for extraction operations. Of course, this is
only the default, and it can be changed via the
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~Directory~
gadget in the

LhA-GUI main interface.

1.23 Changing the compression speed

Compression Speed Gadget

This gadget controls the speed-to-efficiency ratio.

1.24 Changing the I/O Buffer size

I/O Buffer Size Gadget

This gadget controls the I/O buffer size. Better performance results from a
larger buffer!

1.25 LHA option check-boxes

LHA Options

Recursive
This checkbox indicates whether recursive mode is on. If you select
a directory within the archive, its contents will be extracted.
(Checked)

Extract newer files
This checkbox specifies whether LHA will extract only newer files
from the archive if those files already exist in your destination
directory. This proves useful when updating certain software
distributions. (Checked)

Otherwise, the archives files will overwrite the destination dir’s
files, even if they were fresher. (Unchecked)

Ignore filenotes
This checkbox specifies whether LHA will leave filenotes intact for
the files it adds/extracts (Unchecked), or whether it will strip
them (Checked).

Add/Extract is move
This checkbox specifies whether LHA will delete the files from the
archive once they’ve been extracted (Checked), or leave them intact
(Unchecked).

Do not compress
This checkbox specifies whether LHA will compress the files it adds
to the archive (Unchecked), or whether it will simply copy the files
into the archive (Checked).
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Ignore empty dirs
This checkbox specifies whether LHA will archive empty directories
(Unchecked), or whether it will include them in an archive operation
(Checked).

Keep attributes
This checkbox specifies whether LHA will keep the protection bits of
the files it adds/extracts (Checked), or whether it ignores them
(Unchecked).

Pathnames
This checkbox specifies whether LHA will keep the path names of
the files it adds/extracts (Checked), or whether it just adds and
extracts files in a non-hierarchial fashion with no directory
structure (Unchecked).

1.26 AutoExtract AppIcon Option

AutoExtract AppIcon Gadget

This checkbox determines the existence of the AutoExtract AppIcon (Checked)
which can appear on the Workbench as a short-cut for extraction. If you don’t
want this AppIcon cluttering things up, turn off this option (Unchecked).

1.27 Close Gadget Iconifies Setting

Close Gadget Iconifies Gadget

This gadget determines whether the close gadget of LhA-GUI’s main window will
iconify the application (Checked) or quit the application (Unchecked).

1.28 Save preferences changes

Save Gadget

When this gadget is selected, either by the mouse or by its keyboard shortcut
(S),~the~LhA-GUI~preferences currently set up in the Preferences window
are~saved~to~two~locations,~ENVARC: and~ENV: . Also, all further usage of
LhA-GUI (either the currently running~one,~or future~instances)~will use these
settings.

If you’ve made a mistake with the settings, you~can~always~use~the

~Reset~to~Default~
~menu~option~to get back some more sane values and then

select~save~again.

This operation closes the Preferences window.
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1.29 Use preferences changes

Use Gadget

When this gadget is selected, either by the mouse or its keyboard shortcut
(U), the~LhA-GUI~preferences currently set up in the Preferences window is
saved~to~one~locations,~ENV: . Also, all further usage of LhA-GUI (either the
currently running~one,~or future~instances)~will use these settings, until a
reset or power-down.

If you’ve made a mistake with the settings, you~can~always~use~the

~Reset~to~Default~
~menu~option~to get back some more sane values.

This operation closes the Preferences window.

1.30 Cancel preferences changes

Cancel Gadget

When this gadget is selected, either by the mouse or its keyboard shortcut
(C), any changes you’ve made in the Preferences window will be lost, and you
will resume using the previous settings which were in effect.

This operation closes the Preferences window.

1.31 Edit Menu - Reset to Defaults

Reset to Defaults Menu Option

By selecting Reset to Defaults from the Edit menu of the LhA-GUI Preferences
window, or by using the assigned hotkey (Right-Amiga D), you can reset the
LhA-GUI preferences to their default values.

1.32 Edit Menu - Last Saved

Last Saved Menu Option

By selecting Last Saved from the Edit menu of the LhA-GUI Preferences window,
or by using the assigned hotkey (Right-Amiga L), you can reset the LhA-GUI
preferences to the last saved preferences (stored in ENVARC:).

1.33 Edit Menu - Restore
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Restore Menu Option

By selecting Restore from the Edit menu of the LhA-GUI Preferences window, or
by using the assigned hotkey (Right-Amiga R), you can restore the LhA-GUI
preferences to the values which were set up just prior to the Preferences
window opening. Basically, this allows you to cancel any changes you’ve made,
but without closing the Preferences window.

1.34 Viewer Preferences

Viewer Gadget

This string-gadget allows you to enter the name of the application for viewing
archive files when they’ve been double-clicked. The default is Multiview,
which requires AmigaOS 3.0 or higher. You can type in the name of your own
preferred viewer, or use the gadget on the right to bring up a requester for
selecting your viewer.

1.35 Deleting from Archive

Delete Gadget

Once an archive has been loaded, you can select various entries in the
archive~(via the~listview). You~may now select the~Delete gadget, either by
using the mouse or~by using the~keyboard shortcut (D).
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